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This image of Icelandic horses was captured during an offroad vehicle tour 
through the “countryside” of Iceland. This pair seemed especially photogenic, 
so I asked the driver to pull over. Fortunately these horses also approachable, 
allowing me to get quite close to fine-tune the composition.

Now that Photoshop is twenty years old, it might seem that every possible 
feature a photographer could possibly want has already been added. 
And yet, Adobe continues to find new features to add to this powerful 
application. So here we are, witnessing version 12 of Photoshop, dubbed 
“Photoshop CS5”.

To be sure, with each new release of Photoshop it seems the “photo” in 
“Photoshop” becomes less of an emphasis. The new features of Photoshop 
CS5 certainly address the needs of 3D artists and videographers more 
than photographers. But there are still a variety of new features that 
photographers will find helpful in improving the efficiency and flexibility 
of their workflow in optimizing their photographic images.

In this article, I focus on the key features that are of greatest interest (in 
my estimation) to photographers. In the process, you’ll gain a better 
sense of what’s new in this latest release of Photoshop, and be better 
equipped to make a decision about whether an upgrade is worthwhile.

Content Aware Cleanup

The new Content-Aware features of Photoshop CS5 have easily been 
the subject of the greatest amount of coverage leading up to the 
official release of this new version of Photoshop. Before the official 
announcement of this new version was even made, Adobe had 
already provided a “sneak peak” into the advanced capabilities of 
the new Content-Aware options available for the Fill command as well 
as the Spot Healing Brush.
Before diving into the incredible capabilities of this new feature, I feel 
that a reality check is in order. Don’t get me wrong: the Content-Aware 
feature is quite incredible, and represents some of the incredible 
potential of Photoshop moving forward. However, this is the first release 
of this feature, and it isn’t as magical as you might have hoped. One 
of the things I’m concerned about with this new feature is that the 
demonstrations you’ll see at various events will lead you to believe it 
is far more powerful than it actually is. In other words, presenters may 
find just the right image and learn to work with it in just the right way to 
achieve impressive results. I sort of think of the Content-Aware feature as 
being on the same level as the Quick Selection tool. When it works, it is 
truly amazing. And when it doesn’t work out as well as you had hoped, 
it can be a little frustrating. However, in either case, if you step back and 
observe what is happening, the technology is truly impressive.

Photoshop CS5
by TIM GREY
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In other words, the Content-Aware feature is truly remarkable, but it 
won’t provide amazing results in every situation with every image. 
So, temper your expectations, and look forward to even greater 
improvements in future versions of Photoshop.
The more basic capability of the Content-Aware feature is found with 
the Spot Healing Brush. If you’ve worked with the Spot Healing Brush 
in previous versions of Photoshop, you are probably aware that it is 
really just the Healing Brush with the added feature of Photoshop 
selecting the source area for pixels rather than relying upon you 
to choose a source before painting a correction into the image. In 
both cases, once you’ve painted pixels into the image to replace 
a problematic area of the image, Photoshop will blend the source 
pixels into the destination in an effort to ensure the correction blends 
seamlessly in terms of tone, color, and texture.
As you’re probably aware, with the Spot Healing Brush sometimes 
the automatic selection of a source area wouldn’t provide the best 
results, and in many cases if there was a high-contrast edge nearby 
the correction would include a “blooming” effect that could be 
particularly problematic. It was possible to mitigate this at least to 
some degree by creating a selection before working with the Spot 
Healing Brush, but doing so negates much of the benefit of working 
with such an automated tool.
As always, I recommend working with the Spot Healing Brush on a 
new layer created for the express purpose of applying corrections 
to the image. When doing so, it is critical to turn on the Sample All 
Layers option so you’ll be copying pixels onto the new layer based on 
the actual pixels in 
the image. It is also 
important to turn off 
the visibility of any 
adjustment layers 
when working with 
the Spot Healing 
Brush on a separate 
layer to ensure the 
best blending of 
pixels.
The Proximity 
Match option on 
the Options bar can 
be thought of as 
the “old” version of 
the Spot Healing 
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Brush. The new Content-Aware option is 
what you’ll want to select in most cases. 
Doing so causes the Spot Healing Brush 
to behave more intelligently, observing 
surrounding areas of the image when 
applying a correction both for the 
purposes of choosing a better source 
area for pixels to be copied as well as 
resulting in more appropriate blending of 
pixels with their surroundings so you’re 
much less likely to produce blooming of 
the pixels.
It is still best to work with the Spot Healing 
Brush in small areas, using the smallest 
brush size possible for the correction 
you’re applying. If you work carefully, 
the Content-Aware option can be a huge 
benefit. It still won’t produce magical 
results in truly challenging circumstances, 
but it will prove incredibly helpful for a 
wide variety of image-cleanup tasks, such 
as when resolving dust spots in the image 
or cleaning up small areas of debris 
within the scene.
Another implementation of the Content-
Aware feature is found with the Fill 
command. This is the option that is more 
likely to be used to create apparently 
magical results that you might not be 
able to produce with “real world” images. 
When it works, it will prove awe-inspiring. 
But in many cases the results will be less 
than ideal, requiring additional work to 
blend into the rest of the image.
To use the Content-Aware feature of the Fill command, you first need 
to create a copy of the Background image layer by dragging the 
thumbnail for that layer to the Create a New Layer button (the blank 
sheet of paper icon) at the bottom of the Layers panel. Then create 
a selection of the object or area you want to clean up, creating the 
most accurate selection possible that contains the entire area you 
want to clean up but as few extraneous pixels as possible.
Next, choose Edit > Fill from the menu. In the Fill dialog box set the 
Use popup in the Contents section to Content-Aware. Make sure the 
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Cross-Platfor m 64-bit

Macintosh users may have felt 
a little left out with the release 
of Photoshop CS4, since only 
Windows users were able 
to leverage the benefits of a 
64-bit application with that 
version. With the release of 
Photoshop CS5, however, 
Macintosh users now have a 
64-bit version of Photoshop.

What that means for 
photographers is that 
Photoshop is now able to 
access a much larger amount 
of memory (RAM), enabling 
you to work with larger image 
files. This can be a huge 
benefit to photographers 
who are producing large 
composite images such as 
montages or panoramas. It 
can also benefit those who 
produce high dynamic range 
(HDR) images.

In short, if you’ve been 
tempted to utilize the full 
power of a computer with a 
significant amount of memory, 
Photoshop CS5 now enables 
you to take full advantage of 
that power regardless of what 
platform you’re using.

The Content Aware capabilities of Photoshop CS5 are impressive 
when they work effectively, though there are often visible artifacts 
left behind, especially when cleaning up a large area.



Mode is set to Normal and the Opacity is set to 100%. Then click 
OK, and Photoshop will process the results. Note that the process of 
rendering the final result is not exactly fast, even with low-resolution 
images on a fast computer.
Quite often I find the Content-Aware option for the Fill command results 
in far too much duplication of other areas of the image, making it very 
obvious that the image has been tampered with. This is especially 
true when you’re working with a relatively large area of the image. The 
Content-Aware feature, whether used with the Spot Healing Brush or 
the Fill command, is best used in relatively small areas of the image. 
Again, it can be incredibly impressive when it works well, but very 
disappointing when it fails to produce a usable result.

Refine Mask Refinements

The Refine Mask and Refine Edge features are actually the same 
thing. The dialog for each is exactly the same, with all of the same 
controls, the only difference being the title bar of the dialog. Refine 
Mask is used to make adjustments to a layer mask, and Refine 
Edge is used to make adjustments to a selection. Since I always 
recommend creating a layer mask based on a selection rather than 
working on the image directly via a selection, in my mind you would 
never use Refine Edge. Instead, create a layer mask based on the 
selection and then choose the Refine Mask option from the Select 
menu (or click the Mask Edge button on the Masks panel).
The first thing I feel I should mention is that the Refine Mask feature 
has been significantly updated in Photoshop CS5, but it is still not as 
effective in my experience as third-party tools such as Mask Pro from 
onOne Software (www.ononesoftware.com). That said, Refine Mask 
is much improved, and considerably better than the Extract filter that 
had been included previously with Photoshop.
In the View Mode section of the Refine Mask dialog you can choose 
the preview style you prefer from the popup. I generally prefer the 
On Layers option so I can preview the final result. You can also 
turn on the Show Radius checkbox to reveal only the portion of 
the image being evaluated by Photoshop based on your current 
settings (with the rest of the image covered with black), or the Show 
Original checkbox to see the image before any refinement to the 
mask was applied.
The next step is to adjust the Radius value, which determines how large 
an area will be evaluated in refining the mask. For relatively crisp edges 
you would use a low value, whereas for “fuzzy” edges (the types of 
edges you’re most likely to employ Refine Mask for anyway) you would 
want to use a relatively high radius. The actual value will depend upon 06
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how fuzzy the object really is, and 
the resolution of the image. In 
general I find for fuzzy subjects 
a value of around 15 to 20 pixels 
usually works well. Then turn 
on the Smart Radius checkbox 
so the radius will be adjusted 
automatically based on the relative 
contrast at various points along the 
edge of your layer mask.
You can then use the controls in 
the Adjust Edge to further fine-
tune the edge of your layer mask. 
Increasing the Smooth slider will 
smooth out jagged edges along 
the layer mask. The Feather slider 
allows you to adjust the degree 
of softness along the edge, so 
you can prevent a “cutout” look 
when creating a composite 
image, for example. The Contrast 
slider is effectively the opposite 
of Feather, allowing you to tighten 
up a soft edge on the layer mask. 
Shift Edge allows you to expand 
or contract the relative size of the 
layer mask, effectively shifting the position of the layer mask inward 
or outward relative to the edge of the object you’re trying to isolate 
with the layer mask.
To further clean up the result you’re getting at this point, click on the 
Refine Radius Tool to the left of the Edge Detection section. Then 
paint over any areas you want Photoshop to evaluate for the mask. 
This would include particularly fuzzy areas that aren’t coming out 
right, or areas that were masked by mistake. Note that this won’t 
cause a change in areas that were already affected by your settings, 
but rather allows you to expand the area being evaluated. I find this 
most useful for situations where I want to use a small Radius setting 
for most of the image, but then need to paint in specific areas that are 
not included for evaluation based on that settings.
When you’re finished with these refinements, you can make sure 
the Output To option is set to Layer Mask to replace the existing 
layer mask, and then click OK. However, there is also an additional 
option that can be helpful when working on a composite image. If 
you turn on the Decontaminate Colors checkbox and then adjust 
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The Refine Mask dialog allows you to fine-
tune a layer mask with excellent control.



the Amount while evaluating the preview image, you can remove 
color fringing along the edge of the image so it will better blend in 
with its new background.
In addition, you can turn on the Remember Settings checkbox so the 
settings you establish will be the default for future images you work 
on with the Refine Mask command. This is particularly helpful if you 
tend to work on the same type of images (such as portraits), where 
similar settings would likely be used for most images.

Lens Correction Filter

The first thing you might notice if you go looking for the Lens 
Correction filter is that it seems to be missing. Actually, it has only 
been moved to put it in a more accessible location. Instead of being 
“buried” on the Filter > Distort menu (which always felt like you were 
going to create rather than solve problems with the image) the Lens 
Correction filter is now placed near the top of the Filter menu. So you 
simply choose Filter > Lens Correction to get started.
The next thing you’ll likely notice about the Lens Correction filter is 
that all of the controls you’re familiar with seem to have disappeared. 
Don’t worry, all of the controls are still available, but the fact that 
they’re not visible at first hints at the incredible power the Lens 
Correction filter now offers. Instead of requiring you to manually 
apply adjustments to correct for lens distortion, Photoshop can 
apply the corrections automatically. And this isn’t the sort of 
automatic adjustment you need to worry about, where Photoshop 
tries to “guess” at what adjustments should be applied. Rather, the 
adjustments are based on (when available) a profile specific to the 
lens that was used to capture the image.
One of the things I actually appreciate most about the updates to the 
Lens Correction filter is that the grid is now turned off by default, and 
the default size is considerably larger. There’s no question the grid 
can be invaluable in refining the adjustments you apply with Lens 
Correction, but a tiny grid immediately displayed over the image was 
always, at least to me, a bit distracting. If you make any changes to 
the settings for the grid, they are “sticky”, which means the settings 
you select will remain in effect until you make changes to those 
settings again.
The Lens Correction filter will attempt to determine which lens was 
used to capture the image based on metadata values, but if the lens 
shown in the Lens Profiles section (which also reflects a camera 
model, which is really more related to the size of the imaging sensor 
used) doesn’t match the correct lens, you can also set search 
criteria using the available pop-up menus. If you still don’t find the 
right lens, you can click the Search Online button to go to Adobe’s 08
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website. There you 
can search the 
available profiles, 
or even download 
the profile creator 
and build your own 
(which you can 
then share through 
this online service).
Once the correct 
lens is selected, 
you can enable the 
desired options 
in the Correction 
section at the top-
right of the dialog. 
In most cases 
you’ll want to leave the Geometric Distortion checkbox turned on, as 
that’s probably why you would use Lens Correction in the first place. 
This will correct for the distortion caused by curvature imposed on 
the light waves traveling through the lens, which is most commonly 
needed for wide-angle lenses.
If there is any chromatic aberration present (generally seen as 
colored halos along high-contrast edges in the image) you can turn 
on the Chromatic Aberration checkbox to have Lens Correction 
attempt to fix the problem automatically. The Vignette checkbox will 
obviously correct for light falloff at the edges of the frame.
The Auto Scale Image checkbox is also a new feature, allowing 
the image to be automatically scaled (think of this as cropping, 
effectively) to eliminate any “empty” areas from the image. For 
example, if the edges of the image get bowed inward to correct for 
distortion caused by the lens, you’ll need to either crop the image 
(which is what Auto Scale Image will do for you automatically) or 
choose an option from the Edge popup to decide what should 
be done about these areas. Two options are the same as were 
available in prior versions: Edge Extension (which attempts to extend 
the image by adding pixels similar to those near the edges), and 
Transparency (which leaves transparent pixels in those areas). Now, 
instead of the Background Color option you’ll find two new options 
that allow you to fill with Black Color or White Color.
In most cases the automatic adjustments work very well, especially 
when a lens profile is available for the specific lens that was used to 
capture the image. However, the manual controls from prior versions 
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The Lens Correction filter has been significantly updated, providing 
automated adjustments as well as enhanced manual controls.



of Lens Correction are still available. You can use the tools at the 
top-left of the dialog to access these controls, or click the Custom 
tab to access the full complement of controls directly. Note also that 
the Chromatic Aberration sliders are now more precise (fractional 
numbers now are allowed, rather than whole numbers), and there 
is now a Green/Magenta slider to make it easier to deal with the 
common “purple fringe” issue caused by chromatic aberration.
The updates to the Lens Correction may seem simple, but they’re 
actually quite significant in terms of efficiency and quality of results. 
Especially if you tend to work with shorter focal length lenses 
(particularly less than 50mm on a digital SLR), you’ll likely find the 
improvements to Lens Correction particularly valuable.
If after working with the updated Lens Correction filter you find it to 
perform well with the automatic settings, you can even batch-process 
multiple images. Simply choose File > Automate > Lens Correction 
from the menu. In the Lens Correction dialog that appears, choose 
Files or Folder from the popup and click Browse to select the images 
that should be processed (or click the Add Open Files button if you 
already have the images you want adjusted open in Photoshop).
Specify the file format you want to use (JPG, PNG, PSD, or TIFF), 
and click Choose to specify a destination folder. Then turn on the 
Match Best Profile option for automated processing, or turn it off and 
click Choose to select a specific profile (which means all images 
will be processed with the same profile, and thus should have been 
captured with the same camera and lens). Finally, choose the desired 
settings in the Correction Options section and click OK to process 
your images.

Puppet Warp

The new Puppet Warp feature is one of those that is absolutely amazing 
but not likely to be put to use all that often by most photographers. This 
feature allows you to warp areas of an image to your whim. For example, 
imagine a photo of a flower with a straight stem, and being able to warp 
the stem of that flower to form an S-curve.
The trick is, you really need to be working with an object on a separate 
image layer in order to make full use of the Puppet Warp feature. In the 
case of a “normal” photographic image containing an object you want 
to warp, that means you need to first create a layer that only contains 
that object, duplicating pixels from the underlying image layer. You 
would then need to use the Clone Stamp, Healing Brush, or other tools 
(including the content-aware fill option) to remove the object from the 
underlying layer, so that when you warp the object you aren’t simply 
revealing portions of that object in the underlying image.10

   
ddq




   
Photoshop CS5

The odds are extremely high 
that if you see the Puppet 
Warp feature demonstrated 
the presenter will have already 
created an image that has a 
stand-alone object isolated on 
a separate layer floating above 
a background layer. At this 
point the user of Puppet Warp 
is simple. All you need to do is 
click on various points in the 
image to add handles, and then 
manipulate the position of those 
handles to change the shape 
of the object. It is amazing, but 
there is a fair amount of work 
that must go into setting things 
up in the first place. In other 
words, it is a feature that makes 
for a great demo, but one you’re 
not likely to put to much use in a 
typical photography workflow.

HDR Updates

I’m frankly not a big fan of high dynamic range (HDR) imaging. 
In most cases the result looks too artificial, and I tend to not find 
the effect all that pleasing. 
But HDR has become very 
popular. In Photoshop 
CS5 I finally feel that (for 
those who appreciate 
HDR imaging) Photoshop 
can finally be considered 
a solid tool for creating 
these images.
The new HDR Pro feature 
include in Photoshop CS5 
is quite impressive. The 
default settings enable a 
much more realistic result 
than was possible with 
Photoshop CS4, and there 
are many presets to create a 
wide variety of stylized HDR 
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The Puppet Warp feature is quite remarkable, 
though perhaps not something photographers 
are likely to use regularly.

HDR Pro represents a significant improvement in high 
dynamic range image processing in Photoshop.



effects. These presets adjust the various controls available in HDR 
Pro, including tonal adjustments that include Shadow, Highlight, and 
Gamma, a Saturation control, and individual controls that allow you 
to adjust the level of detail and strength and size of the glow effect 
common in stylized HDR images.
In addition, the new Image > Adjustments > HDR Toning command 
allows you to apply similar adjustments to existing images, using all 
the same controls found in HDR Pro.

Mini Bridge

There have certainly been some updates 
to Bridge, and they are reasonably 
noteworthy, but what is more significant 
from my perspective is the new Mini 
Bridge panel in Photoshop.
The Mini Bridge panel is accessible by 
choosing Window > Extensions > Mini 
Bridge from the menu, or by clicking 
the “Mb” button on the application bar 
in Photoshop. In either case, you’ll be 
presented with a small representation of 
the images that are currently available 
within the full Adobe Bridge application. 
As such, Bridge must be running in order 
to display images within Mini Bridge. But 
the Mini Bridge panel is very helpful when 
you’re working with a series of images 
contained in the same folder. Simply 
navigate to the desired folder within Mini 
Bridge or the full Bridge application, and 
you can then open individual files with 
incredible ease simply by using the Mini 
Bridge panel.
You can also apply filters to the images 
being displayed in Mini Bridge by using 
the various controls at the top of the 
Content section.  You can also change the 
presentation of your images (for example, 
thumbnails versus details) using the 
control at the bottom-right of Mini Bridge.

12
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Adobe Camera Raw Update

Adobe Camera Raw has been updated somewhat significantly. The 
issue I believe is important to keep in mind is that now that Lightroom 
depends upon Adobe Camera Raw to ensure a smooth and effective 
workflow. As a result, Adobe Camera Raw must remain in lockstep 
with Lightroom. In other words, whatever improvements have been 
made available through the  Develop module in Lightroom are now 
available through Adobe Camera Raw in Photoshop.
This includes significant improvements to the noise reduction 
capabilities of Adobe Camera Raw. It also includes the ability 
to add simulated film grain to your images. This might seem like 
a silly feature from the perspective of a digital photographer 
trying to minimize the appearance of noise in their photos, but 
many photographers still want to be able to simulate the organic 
appearance of film grain, and that is now possible with Adobe 
Camera Raw.
I’ve always seen Adobe Camera Raw as merely a convenient way 
to get my RAW captures into Photoshop. But one area where I’m 
actually now very impressed with Adobe Camera Raw is in the area 
of noise reduction. Both luminance and color noise reduction have 
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Adobe Camera Raw has been updated significantly, and one of the improvements I’m most 
pleased with is the updated algorithms for noise reduction.

The new Mini Bridge panel 
serves as a convenient portal to 
images you want to browse and 
open in Photoshop.



been significantly improved, and the 
result is noise reduction I can actually 
recommend. In prior versions I would 
suggest that if you need noise reduction 
you should purchase a third-party 
product. With the new improvements 
in Adobe Camera Raw I can now 
recommend using the noise reduction 
capabilities found there instead of a 
third-party solution.
I realize this next “improvement” may not 
seem like an improvement at all to many 
photographers. But Adobe Camera Raw 
also now allows you to add a film grain 
effect to an image. This allows you to 
control the amount of film grain being 
added, as well as the size and roughness 
of the effect. While I consider this to 
be a feature that should only be used 
sparingly, it is a very good effect. In fact, 
it is considerably better than any other 
option available within Photoshop. It offers 
greater control than the Film Grain filter 
available in Photoshop, and better results than can be achieved with 
a variation on the use of the Add Noise filter.
For those who are fond of vignette effects (and even those eager to 
eliminate vignetting caused by the lens), the Post Crop Vignetting 
improvements will be welcomed. Of course, I prefer not to crop at 
all within Camera Raw, so I don’t see this as a significant benefit. 
However, the new options are rather impressive.
In addition to the controls that were previously available, there is now 
a Style popup for Post Crop Vignetting, which is now in the Effects 
section of Camera Raw rather than the Lens Corrections section. The 
Highlight Priority option will preserve details in bright highlights. This 
produces, in my opinion, a much more pleasing look for particularly 
bright areas that are being affected by the vignette, as it prevents 
the muddy appearance that can be common in such situations. The 
Color Priority option will help ensure the appearance of colors is 
retained, so they aren’t shifted toward more neutral values. With both 
of these options you can also utilize the Highlights slider (though only 
if you’re applying a darkening rather than lightening effect with the 
Amount slider). The Paint Overlay option produces an effect similar to 
what would be achieved with prior versions.

14
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New Feature Grab Bag

When it comes to new features of interest to photographers, there are 
a handful of features that seem very big. Those are the features likely 
to get the most attention, though frankly I do wonder whether that 
attention is deserved. On balance, it seems to me that the greatest 
value for photographers when it comes to Photoshop CS5 is the 
relatively long list of minor updates that don’t seem significant and yet 
make a big difference in the photographer’s workflow.
A discussion of Photoshop CS5 wouldn’t be complete without 
coverage of the many relatively minor new features that are of interest 
to photographers. So, without further ado, I’ll outline those features.
The Crop tool finally includes the ability to display a grid over the 
image that represents the rule of thirds. You can also turn off the 
grid, or set it to a true “grid” display that provides a more accurate 
display for aligning horizontal or vertical lines within the image as you 
apply rotation. To enable this feature, first draw your basic crop (so 
the controls on the Options bar will change to reflect those available 
while you’re defining the crop) and choose the desired option from 
the Crop Guide Overlay popup. The options are “None”, “Rule of 
Thirds”, and “Grid”.
There are a couple of new “head-up display” (HUD) options that I 
find very helpful. First, if you use the Eyedropper tool to select a color 
from within the image (which I do regularly when I need to apply a 
color correction in another area of the image, for example), you can 
now see an on-screen display that can be very helpful. There are 
two concentric rings. The outer ring is middle gray, helping to reduce 
the influence of other colors on your perception of the colors you’re 
picking. The lower 
half of the inner 
ring shows the 
current color that is 
already selected, 
and the upper half 
displays the color 
your mouse is 
currently hovering 
over. This makes 
it easy to instantly 
get a sense of the 
color you’ll select 
if you click the 
mouse, and also 
to compare that 
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What About Extended?

While both the Standard 
and Extended editions 
of Photoshop have been 
updated with the CS5 release, 
the focus of the Extended 
edition remains on scientific 
and 3D applications. As 
a result, there’s really no 
need for the vast majority of 
photographers to spend the 
extra money for the Extended 
edition.

Naturally if you’re involved in 
photography from a scientific 
perspective, or if you also 
work with 3D modeling, 
you may want to consider 
the Extended edition. But 
for typical photography 
applications the Standard 
edition will more than meet 
your needs.

The new Rule of Thirds and Grid displays for the Crop tool are 
an example of small features that can make a big difference in 
your workflow.



color to the existing color. I find 
this extremely helpful when I’ve 
picked the wrong color and need 
to find a slightly different color. 
For example, if I need a shade 
of orange and the color I initially 
picked is too red, this display 
makes it easy to evaluate colors 
since you can see very clearly 
how the color you’re about to 
choose differs from the previously 
selected color.
The HUD color picker is another 
nice addition, though one that is 
complicated to explain. To view 
this color picker, you hold the Shift 
and Alt keys and then hold the 
right mouse button on Windows 
(hold Command, Option, and 
Control keys and then hold the 
left mouse button on Macintosh). 
Once you’ve clicked you can 
release the keys on the keyboard 
but you must continue to hold the 
mouse button down. Then simply 
drag the mouse around to select a color. The larger area at the left 
allows you to adjust the saturation and brightness, and the vertical 
gradient on the right allows you to adjust the hue. If you would like 
to lock the current position of the control so you can move your 
mouse over to the other (for example, so you can move over to the 
saturation/brightness control after selecting a huge), simply hold the 
Spacebar key. While holding the Spacebar the controls are locked, 
and you can release the Spacebar again to further refine the currently 
selected color. A ring around the mouse pointer shows the previously 
selected color on the top and middle gray on the bottom.
One new feature I’m not particularly fond of (which in fairness 
may very well mean I just haven’t gotten used to it yet) is the new 
behavior when dragging with the Zoom tool. Instead of dragging 
to draw a marquee over the area you want to get a closer look 
at, now the Zoom tool allows you to smoothly zoom in or out by 
dragging. Simply drag left to zoom out or right to zoom in. This works 
regardless of whether Zoom tool is active or if you are accessing 
it temporarily by holding the Z key or the Ctrl+Spacebar shortcut 
(Command+Spacebar on Macintosh). Since this feature makes use 
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of OpenGL Drawing, you can disable this feature in order to return 
to the “old” behavior by turning off the Enable OpenGL Drawing 
checkbox on the Performance tab of the Preferences dialog. Of 
course, doing so will also disable other features that make use of 
OpenGL, including the very cool HUD color picker and the on-image 
preview for the Eyedropper tool.
There are also a variety of relatively small (in some cases tiny) and yet 
meaningful improvements. I think of these as being some of those nice 
refinements that provide a more pleasing user experience and in some 
cases greater workflow efficiency, but they’re not exactly features that 
will make you rush out to buy the upgrade. These include:

•	 A Straighten button on the Options bar for the Ruler tool, so 
that once you’ve measured a line that should be perfectly 
horizontal or vertical you can apply an automatic straightening 
(rotation and cropping) of the image without the need to then 
rotate and crop as separate steps.

•	 There is a script that can automatically remove all layers that 
don’t contain any pixels, found on the menu at File > Scripts > 
Delete All Empty Layers.

•	 You can save a 16-bit per channel image directly to an 8-bit 
per channel JPEG without the need to convert to the 8-bit per 
channel mode manually.

•	 If you choose the “Don’t Ask Again” option when prompted 
about the Maximize Compatibility option for saving Photoshop 
PSD files, the setting you’ve established will automatically 
update the setting in Preferences so that option will be used 
for all PSD files moving forward.

•	 There is now an Apply to All checkbox in the dialog that 
prompts whether you want to save changes when you choose 
File > Close All from the menu. Turning on this checkbox 
enables you to choose the option not to save changes, and 
have all open images closed immediately.

•	 A “Save As to Original Folder” option has been added to 
the File Handling section of the Preferences dialog. With this 
option turned on, whenever you choose the File > Save As 
command from the menu, the default folder will be the folder 
the current image was last saved in.

•	 You can select multiple layers on the Layers panel (click on the 
first layer you want to select and then hold Shift and click on the 
last layer in the range of layers you want to select), and then 
adjust the Opacity control at the top-right of the Layers panel to 
adjust the Opacity for all of the selected layers at once.
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The HUD display for the Eyedropper tool the 
and related HUD color picker provide useful 
efficiency when selecting colors.



•	 Each page of the Layer Style dialog now has a Make Default 
button so you can establish your own personalized default 
settings for each effect. There is also a Reset to Default button 
that will return all of the settings for the current effect to the 
defaults you have saved.

•	 You can now include print settings as part of actions, helping 
enable automated print workflows that don’t sacrifice color 
accuracy or workflow efficiency.

•	 The layer groups feature (covered in great detail in a separate 
article in this issue) now allows you to nest up to ten layer 
groups deep rather than only five. However, keep in mind this 
can introduce a compatibility problem if you share files that 
contain nested layer groups with other users who have not 
upgraded to Photoshop CS5.

•	 The Gradient tool now includes a Neutral Density preset that 
allows you to apply a gradient darkening effect to an image 
quickly, for example to darken a bright sky to better match 
the overall scene. This is handy, though I personally prefer to 
customize the effect a bit more, generally using a standard 
gradient layer mask with an adjustment layer (such as Curves) 
used to darken the image. If you do make use of this new 
Neutral Density preset, I suggest adding a new empty layer 
above your image layer(s) first and add the gradient to that 
new empty layer.

•	 If you drag an image into Photoshop CS5 with an existing 
image open, the image you drag will become a layer in the 
existing document, rather than being opened as a separate 
file. This can either be a good thing or a bad thing depending 
on your personal workflow style and preferences.

•	 You can force a text field to have the focus on the Adjustments 
panel by pressing Shift+Enter (Shift+Return on Macintosh). 
This allows you to then type a value manually, press the up 
or down arrow keys to increase or decrease a value (adding 
Shift to adjust by a factor of ten), and navigate among the 
fields by pressing Tab to move forward or Shift+Tab to move 
backward.

•	 Really intended for those who are truly creating virtual 
paintings in Photoshop, but useful in some cases for 
photographers, the painting engine has been greatly 
improved. A new Mixer Brush tool is available, and many new 
options are also available for dealing with how the brush tools 
and the virtual “paint” you draw with behave.
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The $199 Question

Before I hear questions about the new features in the latest version 
of Photoshop, I hear the standard question: Is it worth the upgrade 
price? This is actually a very difficult question to answer. I almost 
always think photographers should upgrade to the latest version of 
Photoshop. I feel it is valuable to stay current on the latest features, 
there tends to be an advantage in terms of bugs from prior versions 
being fixed, and it helps avoid potential compatibility problems (such 
as the inability to upgrade to the latest version of Adobe Camera Raw 
if you’re not using the latest version of Photoshop).
With Photoshop CS5 it is a bit more challenging because there are 
basically two categories of new features. The first category is what 
I think of as the “big” new features that have some cool potential 
but aren’t always as good as we would hope. This is the category 
that would cause me to hesitate a little on the upgrade question. 
The second category is the large number of small features. This is 
actually the category that I think tips the scales in favor of upgrading. 
If you look at each of these updates and new features individually, 
they likely wouldn’t inspire you to upgrade. But when taken as a 
whole, they represent many small updates that make a big difference 
in how you work in Photoshop.
I realize this is a $199 question, but taken in context with all the other 
things photographers spend money on, I still think the upgrade price 
still represents a good value. >>
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I still find it surprising how often I present some of the features of layer 
groups in Photoshop, only to find that quite a few photographers in 
the audience never knew this feature existed even though it has been 
around since Photoshop 7, which was released in 2002 (yes, it really 
has been that long). I suppose I really shouldn’t be surprised that 
many photographers aren’t familiar with the layer group feature, since 
Photoshop is such an incredibly complex (and powerful) application, and 
this is a feature that doesn’t really get discussed all that often.

In my mind, what all that really means is that layer groups may be one 
of the “best kept secrets” in all of Photoshop. In a variety of ways, layer 
groups allow you to be more organized with your images, and to apply 
powerful adjustments in a very flexible and efficient way.

Organizational Tool

Layer groups (they were actually called “layer sets” when first 
released in Photoshop 7, but re-branded in Photoshop CS) were 
originally designed as an organizational tool. As you probably 
realized long ago, it is quite easy to end up with a particularly large 
number of layers in Photoshop, and sometimes that can cause you 
to feel a little overwhelmed. This is especially the case for more 
complex images that include multiple image layers (such as with a 
montage, for example), and perhaps various text layers, adjustment 
layers, and other layers that can quickly clutter up the Layers panel.
A layer group is, quite simply, a virtual folder on the Layers panel that 
allows you to divide various layers into logical groups, helping you to 
stay more organized. But layer groups also unlock some additional 
capabilities that are, in my opinion, quite remarkable from the 
standpoint of an advanced image-optimization workflow.

Creating a Layer Group

To get a feel for the concept of layer groups, I think it is best to 
dive right in and work with layer groups on a test image file. While 
everything I’ll guide you through in this article is non-destructive, I 
still recommend working with a copy of one of your images rather 
than an original, if for no other reason than as you explore the various 
options working with layer groups you may create a lot of clutter on 
the Layers panel you won’t want to keep.

Group Benefits

The fastest and easiest way to create a new layer group is to click 
on the Create a New Group layer (the folder icon) at the bottom of 
the Layers panel. When you do so, a new layer group will be created 
directly above the currently active layer (presumably the Background 
layer at this point) on the Layers panel.
The first layer group will be named Group 1 by default, with each new 
layer group you add receiving the next number in series (Group 2, 
Group 3, and so on). I highly recommend renaming your layer groups 
with something more meaningful, just to maximize the organizational 
benefit they provide. To rename the layer group, simply double-
click on the name of the layer group on the Layers panel, type a 
new name, and press Enter/Return. I recommend naming the layer 
group based on the intended purpose. For example, if you’re using 
the layer group to apply a set of adjustments that will only affect the 
sky, you could name the group “Sky Adjustment”. The point is to use 
something meaningful so you’ll know why the layer group is there 
when viewing the Layers panel.
Since you’re likely to rename the layer group anyway, it can also be 
helpful to provide a name at the time you actually create the group. 
As you would probably expect, there are several ways you can go 
about this. The easiest approach in my view is to simply hold the Alt 
key (Option key on Macintosh) while clicking the Create a New Group 
button at the bottom of the Layers panel. Doing so will cause the New 
Group dialog box to appear. The default name will appear in the Name 
field, but you can type a new name to assign to the layer group.
You can also assign a color to the group you’re creating using the 
Color popup in the New Group dialog box. Simply choose one of 
the available options (including “None” if you don’t want any color 
applied). The selected color will be used as shading for the “eye” 
icon to the left of the layer group on the Layers panel.
If you didn’t assign a color when you first created the layer group, or 
you later decide you want to change (or remove) the color, you can 
do so by changing the properties for the layer group. Simply double-
click in the empty area around the name for the layer group on the 
Layers panel. You 
can also click 
the side menu 
button at the 
top-right corner 
of the Layers 
panel and choose 
Group Properties 
from the popup 

If you hold the Alt (Windows) or Option (Macintosh) key while 
clicking the Create a New Group button, the New Group dialog will 
be presented, allowing you to adjust the settings for the group.



menu or choose Layer > Group 
Properties from the main menu 
bar in Photoshop. Any of these 
options will bring up the Group 
Properties dialog box, where you 
can choose a different color (or 
“None”) from the Color popup. 
You can also modify the name for 
the layer group in this dialog box.
Of less interest in the Group 
Properties dialog box are the 
Channels checkboxes. By default 
all three of these channels (R, 
G, and B, for red, green, and 
blue, respectively) are turned 
on, and in the vast majority of 
cases that’s exactly what you 
want. If for some reason (such 
as a unique creative effect or 
serious color correction issue) you want the items contained within 
the layer group to only affect specific channels, you can turn off the 
checkbox for the channels you don’t want to affect. Once you’ve 
adjusted the properties for the layer group, click OK to close the 
Group Properties dialog box.

Working with a Layer Group

The whole purpose of a layer group, of course, is to actually put 
something inside of that layer group. In the context of an image-
optimization workflow, that means adjustment layers and image 
layers. I’ll talk more about the particulars of doing so, but for now 
let’s assume we want to organize a set of adjustment layers that are 
affecting the entire image. We’ll further assume for the moment that 
you created the adjustment layers before you decided to organize 
them into a layer group. As a result, those adjustment layers are on 
par with the layer group, not contained within the layer group.
To place a layer (whether it is an adjustment layer or an image layer) 
inside a layer group, simply point to the layer you want to place 
inside the layer group and then drag and drop the thumbnail for that 
layer onto the folder icon for the layer group. This will cause the layer 
to be placed inside the layer group, as indicated by the fact that the 
layer will then be below the layer group and indented slightly. You 
can drag any other layers onto the thumbnail for the layer group, and 
they will also be placed inside the layer group.
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As I mentioned at the beginning of this article, layer groups were 
originally added to Photoshop in large part to provide some 
organization for the Layers panel. At this point adding a layer group 
has only served to make the Layers panel more complex, by virtue 
of the fact that there’s simply another “layer” on the list shown there. 
However, you can collapse layer groups to hide their contents, which 
provides an excellent solution for a variety of situations.
To collapse a layer group simply click on the triangle icon to the left of 
the folder icon for the layer group on the Layers panel. This triangle 
serves as a toggle, meaning it will collapse or expand the layer group 
depending on the current state of that layer group when you click on it. 
When a layer group is collapsed the contents will be hidden, helping to 
reduce the amount of clutter on the Layers panel. And, of course, when 
you expand a layer group the contents will be revealed, all of which will 
appear indented below the layer group they are contained in.
At times you may find you need to drag a layer out of a layer group, 
which can actually be slightly challenging. When you have multiple 
layer groups and a series of layers both inside and outside the layer 
group it isn’t quite as challenging, but in many cases you’ll have only 
a Background image layer and a layer group with one or more layers 
inside that layer group, and you want to drag one or more layers out 
of the layer group.
The key to dragging a layer out of a layer group has to do with 
precise positioning of your mouse before releasing the mouse button. 
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If you assign a color to a layer group, the color 
will appear to the left of the layer group on the 
Layers panel.

Collapsing a layer group temporarily hides the layers contained within the group, which can 
help remove clutter from the Layers panel.



You need to pay close attention to the indicators on the Layers panel 
when performing this task. What you want to see is a horizontal bar 
spanning the width of the Layers panel in the position you want to 
place the layer you are removing from a layer group. For example, 
if you have only a Background image layer and a layer group 
containing one or more layers, you may want to drag an adjustment 
layer outside the layer group. That will generally involve dragging the 
adjustment layer to a position above the layer group on the Layers 
panel. Therefore, you would click on the thumbnail for the appropriate 
adjustment layer, and then click and drag toward the top of the 
Layers panel. If you drag too high you’ll see a hand icon for your 
mouse pointer without any other indication. In the correct position, 
you’ll see a horizontal bar between the top-most layer on the Layers 
panel and the top of the space dedicated to layers. If you drag too 
low, you’ll likely see a box indicating that the layer will be placed 
into the layer group. Even lower and you’ll see the “circle with a 
slash” icon that indicates you can’t drop the layer in that position (for 
example, directly onto the Background image layer).
Naturally, if you decide later you want to put a particular layer back 
inside a layer group, you can simply drag the thumbnail for that layer 
to the thumbnail for the appropriate layer group.

Automatic Grouping

From time to time you may run into a situation where you decide after 
creating a group of layers that you’d like those layers to be placed 
into a layer group, but you haven’t yet created a layer group to 
contain those layers. This is especially true for situations where you 
decide you want to create multiple interpretations of an image, as I’ll 
explain in the next section.
The first step in automatically adding multiple layers (or even a single 
layer) into a layer group is to select those layers. Start by clicking 
the first layer and then holding the Shift key and clicking on the last 
layer. This will select all of the layers in between the first and last you 
clicked, so they are all ready to be added to a new layer group.
By the way, unfortunately there isn’t a way to select layers that are 
not contiguous on the Layers panel. So for example, if there are four 
layers in a row and you don’t want one of the “in between” layers 
to be included in a layer group, you can’t select all but that one in 
between layer. You would need to manually drag some or all of the 
layers into or out of the layer group after creating that layer group.
The next step is to create a new layer group. Because you already 
have one or more layers selected on the Layers panel, you can have 
those layers automatically added to the new layer group when it is 24
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created. To do so hold the Ctrl key (Command key on Macintosh) 
and press G to create a new group. A new layer group will be 
created, and the layers you had selected will automatically be placed 
inside that layer group. The new layer group will also be collapsed 
by default, so the clutter on the Layers panel will be immediately 
reduced. You can produce the same effect, by the way, by dragging 
the thumbnail for any of the currently selected layers to the Create a 
New Group (the folder icon) at the bottom of the Layers panel.
As an alternative to the keyboard options presented above, you also 
have a couple of menu options you can use to create a new layer 
group after you have selected the layers to be placed within that 
layer group. From the side menu on the Layers panel you can choose 
New Group From Layers, or you can choose Layer > New > Group 
From Layers from the main menu. For both of these options the New 
Group From Layers dialog box will be presented. This dialog box is 
an exact copy of the New Group dialog box discussed previously, 
with the only difference being the title of the dialog box.

Ungrouping Layers

If at any time you decide you want to remove a layer group without 
losing the contents of that layer group, you can simply ungroup the 
contents and retain them in their current location (outside of the layer 
group you’re removing, of course).
To ungroup the contents of a layer group, first click on the icon for 
that layer group on the Layers panel. Then choose Layer > Ungroup 
Layers from the menu, or hold Ctrl+Shift (Command+Shift on 
Macintosh) and press G on the keyboard. The layer group will be 
removed, and all contents of that layer group will be left behind in the 
position that had been previously held by the layer group.

Version Control

At this point you have a strong foundation for the functionality of layer 
groups. However, that knowledge doesn’t necessarily provide you 
with the ability to put layer groups to use in a real-world workflow, 
other than potentially cleaning up what could become a very 
cluttered Layers panel for certain images.
One of the most basic ways to leverage layer groups is to include multiple 
versions of an image within a single master image file. For example, you 
might create both a color and black & white version of an image, and 
utilize the same multi-layered Photoshop PSD file to contain both versions 
rather than having to manage individual files for each interpretation of the 
image. This is also a great way to enable more experimentation with your 
images as you determine how you want that image presented.
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The chances are good that you tend to approach an image with a 
single vision in mind, and then later through the process of optimizing 
that image you decide you’d like to explore a different interpretation 
of the image. The initial adjustments you’ve applied are therefore 
not likely to be contained within a layer group, so the first step is to 
create a new layer group that contains all of the adjustments you’ve 
applied, as discussed earlier in this article. It is a good idea to name 
this layer with a brief description of the adjustments you’ve applied, 
which will make it easier to switch between different versions or fine-
tune your adjustments later.
Once you’ve created a layer group that contains the adjustments 
you’ve applied, you could start creating new adjustments in a new 
layer group by simply creating a new group and placing additional 
adjustment layers in that group. Be aware, however, that a new layer 
group will be placed inside a current layer group (just as a new 
adjustment layer would) if the layer group is expanded and selected, 
or if a layer inside the layer group is selected. To ensure the new 
layer group is placed outside the existing layer group, first collapse 
the existing layer group. This will cause a layer group (or any other 
new image or adjustment layer) to be placed above the current layer 
group, and not contained within that existing layer group.
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In many cases you may find the existing adjustments you’ve applied 
represent a good starting point for creating a different interpretation 
for your image. For example, instead of making a dramatically 
different version you may simply want to have two versions where 
you use the same adjustments but with slightly different settings. In 
such a case it may be helpful to start from a duplicate copy of the 
original layer group. To create a copy, first select the layer group on 
the Layers panel, and then choose Layer > Duplicate Group from 
the menu. This will bring up the Duplicate Group dialog box, where 
you can enter a name for the new layer group in the As field. It is also 
possible to duplicate the group to a different document (which can 
be helpful for applying the same adjustments to different images), 
including to a new document, but in this context you’ll want to 
duplicate the layer group within the same document. After entering 
a name that is meaningful with reference to the final appearance you 
intend for this image, click OK.
You can also duplicate a layer group by dragging the thumbnail for 
that layer group to the Create a New Layer button (the blank sheet 
of paper icon) at the bottom of the Layers panel. This will create a 
copy of the layer group, with the word “copy” appended. You can 
change the name to something more meaningful by simply double-
clicking on the name for the new layer group, typing a new name, 
and pressing Enter/Return.
Once you’ve created a copy of the original layer group, you’ll likely 
notice a dramatic change in the appearance of the image, because 
the same adjustments are now being applied twice to the image. The 
key to using this approach to contain multiple adjustment versions of 
your image within the same document is to only have one of the layer 
groups visible at any given time. To toggle the visibility off or on for 
any layer group, simply click the eye icon to the left of the thumbnail 
for the layer group. You can then turn off all but the one layer group 
containing the adjustments you want to work with.
It is important to keep in mind not only that you need to make sure 
the appropriate layer group is visible with others turned off, but 
also that you need to be careful to ensure you are working with the 
correct adjustment layer within the correct layer group whenever 
you’re fine-tuning the image. While adding layer groups in this 
manner can greatly improve your flexibility and organization, it also 
adds a certain level of complexity. The key is to pay attention to 
which group and layers you’re working with, and taking your time to 
ensure you’re achieving the intended result. ddq
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One of the key benefits of layer groups is the ability to create different interpretations of an 
image within the same image file.



Layer Masks

By far the most important 
reason to work with layer groups 
in my mind is the ability to utilize 
a layer mask with a layer group. 
Doing so allows you to use a 
single layer mask to constrain 
multiple adjustment layers so 
they only affect a single area of 
the image. The alternative is to 
use individual layer masks with 
individual adjustment layers. But 
if those adjustment layers are all 
intended to apply to the same 
area of the image, if you later 
discover the layer mask isn’t 
quite perfect you need to fix the 
multiple layer masks associated 
with the multiple adjustment 
layers.
To add an adjustment layer 
to an existing layer group, simply select the layer group on the 
Layers panel by clicking on its thumbnail and then click the Add 
Layer Mask button (the circle inside of a square icon) at the 
bottom of the Layers panel. If you want to use a selection as the 
basis of the layer mask, simply create the selection before adding 
the layer mask. With a selection active when you add a layer 
mask, that layer mask will automatically reflect the shape of the 
selection, so that the contents of the layer mask will only affect the 
area defined by the selection.
Once you’ve added a layer mask to a layer group, the entire contents 
of the layer group will only be visible based on the layer mask. The 
contents will be visible where the layer mask is white, hidden where 
the layer mask is black, and partially visible in areas where there 
are shades of gray on the layer mask. As such, you can paint on the 
layer mask to fine-tune where the contents of the layer group are 
visible or hidden.

Nesting Groups

To really maximize the power of layer groups, you can take 
advantage of the ability to nest one layer group inside of another. This 
provides a benefit both in terms of organizing multiple image layers 
as well as providing more advanced layer masking capabilities.
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You’ve already learned how to use a single layer group with a 
collection of layers to help organize and de-clutter the Layers panel. 
In some cases you will find it helpful to utilize multiple layers of layer 
groups in order to further divide layers into groups and sub-groups. 
Admittedly, I don’t find too many situations with a normal photographic 
image where I put this capability to use. Rather, I tend to use it when 
creating more complicated documents, such as website graphics or 
printed output that includes multiple images and text.
For example, when working with a complex montage image, I will 
create a layer group to contain all of the text layers, and another layer 
group to contain the image layers. However, I often find it helpful in 
these situations to also create sub-groups. For example, I’ll divide 
text between title text for the printed page and captions for individual 
photos, with each set contained in a separate layer group and both 
of those layer groups placed into a “Text” layer group.
The process of creating multiple levels of layer group is very easy. 
Simply create the first group and place the desired layers within that 
layer group. Then create a new layer group and drag the first group 
into the second group. Just as you can tell when a layer is contained 
within a layer group by virtue of 
the fact that a contained layer is 
indented below the layer group.
You can actually nest layer 
groups up to ten deep in 
Photoshop CS5, which provides 
quite a bit of flexibility (and 
possibly more complexity than 
you want or need). In prior 
versions of Photoshop it was 
possible to nest layer groups up 
to five deep.
While I do find the nesting 
of layer groups helpful in 
certain situations for a purely 
organizational benefit, where 
they really come in handy is for 
using multiple layer masks with 
a single group of layers. As I 
discussed earlier in this article, 
it is beneficial to place a set of 
adjustment layers inside a layer 
group and then use a layer 
mask attached to that layer 
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When you attach a layer mask to a layer group, 
all of the adjustments (or other layers) within the 
layer group will only affect the area defined by 
the layer mask.

By nesting layer groups you can cause more 
than one layer mask to constrain the behavior 
of a set of adjustment layers. In this case a set of 
adjustments are affecting only the background, 
but in a gradient fashion.



group to constrain the behavior of the adjustment layers based on 
the layer mask. By doing so you only have to refine one layer mask to 
change where all of the adjustment layers within a layer group have 
an effect, rather than adjusting layer masks for each of the individual 
adjustment layers.
However, by combining the ability to nest layer groups with the 
ability to add a layer mask to each of the layer groups, you can 
expand the power of your layer masking. The most common 
scenario for me is to apply a set of adjustments that only affect one 
area of the image (for example, the sky), and affect that area in a 
gradient fashion (for example, a stronger effect at the top of the 
sky than at the bottom). The solution is to first create a single layer 
group with a layer mask attached, and place your adjustments 
inside that layer group. You can then create another layer group 
and add a layer mask to that layer group. Then drag the first layer 
group that contains the adjustments and drop it on the second layer 
group. In effect this will cause a result as though both layer masks 
were blended together into one, constraining the adjustments so 
they are only visible in areas where both layer masks would cause 
them to be visible. Once you’ve created this structure you can then 
fine-tune either of the layer masks.
And, of course, you can still nest the layer groups up to ten deep 
(five deep with versions prior to Photoshop CS5) to create incredibly 
complex layer mask structures. I’ve actually never found a situation 
where I needed more than two layer masks used in this way, but it is 
nice to know there is additional power waiting for you if you need it.

Pass Through Blend Mode

You may have noticed when working with the New Group dialog box 
or by looking at the blend mode popup at the top-left of the Layers 
panel that you can establish a blend mode for a layer group. The 
default blend mode is Pass Through, which can sort of be thought of 
as a blend mode that causes no interference at all. In other words, 
it makes the layers in the blend mode affect all layers below them, 
whether or not any other layers are inside or outside the current layer 
group. This makes sense in the context of using layer groups for 
organizational purposes, because in that case you really don’t want 
the layer group to interfere with the various layers that comprise your 
overall image.
However, in certain situations you actually don’t want the effect of the 
adjustment layers within a layer group to affect any layers outside 
that layer group. Good examples include a photo montage, where 
you want to apply specific adjustments to individual image layers 
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within the composition, or 
composite panoramic images 
where you need to apply 
individual layers to adjust them 
so they match perfectly with 
adjoining layers.
In such a case the solution is 
to create the individual layer 
groups, and then place image 
layers and adjustment layers 
within the layer group based 
on how you want to isolate 
those layers for adjustment. 
For example, with a composite 
panorama you would place 
a single frame of the overall 
panorama into each layer 
group, and add adjustment 
layers as needed to each 
of those layer groups in 
order to make the necessary 
adjustments. For a photo 
montage the same basic 
process would apply, except 
that you might want to place 
more than one image layer 
into a given layer group if you 
wanted to apply the same 
adjustments to certain image.
It is important to keep in mind 
that within the layer group the 
order of layers is still important. 
Specifically, image layers 
need to be placed below any 
and all adjustment layers so those adjustments will actually apply 
to the image layer. In other words, the behavior inside a layer group 
is the same as the layer you would expect without the use of layer 
groups for layers on the Layers panel, with the only real difference 
being that when layer groups are involved things can get a bit 
more complicated. However, that complication can greatly increase 
your efficiency, flexibility, and power in Photoshop, so they are well 
becoming familiar with. >>
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The Normal blend mode will constrain the 
contents of a layer group so only the layers 
within that layer group are affected.



Layout Updates

You may have noticed some slight changes to the layout for Digital 
Darkroom Quarterly. In particular, the “Letter from the Editor” page 
has been removed to provide more space for the informative content 
presented in each issue. Hopefully you find these updates helpful. 
Your feedback is certainly welcome as Digital Darkroom Quarterly 
continues to evolve and improve to better meet your needs.

Click! California Photo Festival

Tim Grey will be participating in the Click! California Photo Festival 
hosted by Light Photographic Workshops on the beautiful central 
coast of California. This even will be held September 21-26, 2010 
with presentations in San Luis Obispo, Morro Bay, Paso Robles, Los 
Osos, Cayucos, San Simeon, and more. In addition to Tim Grey, other 
presenters will include Hanson Fong, Rob Sheppard, Jim DiVitale, 
Jack Davis, Jane Conner-Ziser, and many others. This is the first 
Click! event, and it promises to be a tremendous learning experience 
and a great deal of fun. For more information, or to register, visit the 
event website at www.californiaphotofest.com.

DVD Price Reduction

Tim Grey’s “Photoshop Hands-On” series of video tutorial 
DVDs have been praised as excellent learning tools for digital 
photographers working to master Photoshop. The current series 
was recorded using Photoshop CS4, but the vast majority of the 
content is still applicable to the new Photoshop CS5. However, in 
consideration for the fact that the new features of Photoshop CS5 
are not covered on the existing DVDs, the price has been reduced 
to only $20. This is a tremendous bargain, and you can take 
advantage of this new pricing by placing an order for any of the 
DVDs through Tim Grey’s online store at www.timgrey.com/store/.

In the Next Issue

The next issue of Digital Darkroom Quarterly will be the Summer 2010 
issue, and it will be mailed in July 2010. Articles will include coverage 
of the latest version of Adobe Photoshop Lightroom, and much more.

Upcoming...
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